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In This Guide ...
In This Guide ...

This guide contains reference information on the interface between 
ChemStation and OpenLAB ECM, on the settings required by 21 CFR Part 11, 
and on the workflows for ChemStation with ECM.

1 Introduction

This chapter introduces the ECM implementation in OpenLAB CDS 
ChemStation Edition and the requirements of 21 CFR Part 11.

2 Basic Concepts of ChemStation with OpenLAB ECM

This chapter describes how to log in to ECM in ChemStation, and explains the 
ECM-related user interface items and toolbars, as well as the main preference 
settings.

3 Working With ChemStation and ECM

This chapter describes the basic workflows for ChemStation with ECM. There 
are four data-related workflows and two workflows for methods, sequence 
templates, or report templates.

4 Administration Regarding 21 CFR Part 11 Compliance

This chapter explains the purpose of 21 CFR Part 11 and its implementation in 
ChemStation with OpenLAB ECM

5 Attribute Extraction Services for ChemStation Data

This chapter provides an overview of the available ECM Attribute Extraction 
Services (AES) for ChemStation data. The AES extract metadata information 
from the ChemStation data files. These metadata make the ChemStation data 
searchable. For detailed information, refer to the ECM documentation.

6 Troubleshooting

The chapter gives some elementary troubleshooting hints.

7 Appendix
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1 Introduction
What is ECM?
What is ECM?

The Agilent Enterprise Content Manager (ECM) is a web-based electronic 
library that allows you to safely archive and catalog any electronic file. ECM 
allows you to store and index analytical raw data, reports, and all other types 
of documents. The stored files can be shared with other users. 

You can store any electronic file type, such as Microsoft Office documents, 
Adobe PDF documents, images, and molecular drawings, as well as raw data 
and reports generated by ChemStation.

ECM allows you to easily collect, organize, search, and review all of your data. 
It automatically extracts searchable metadata from files, and provides 
powerful search capabilities. In addition, ECM provides embedded viewers for 
many file types.

The ECM interface is opened via Microsoft Internet Explorer, also referred to 
as the ECM Web Client.
8 ChemStation with ECM Concepts Guide



Introduction 1
Using ChemStation with ECM
Using ChemStation with ECM

OpenLAB CDS ChemStation Edition provides an interface to the Agilent 
Enterprise Content Manager (ECM), which enables you to store analytical data 
and reports in a secure location. From ChemStation, you can log in to ECM 
and store methods, sequence templates, data files, report templates, and 
generated reports in ECM. Data storage can be either automatic (that is, at the 
end of a single run or sequence) or manual. ChemStation data stored in ECM 
can later be downloaded to ChemStation for review or reprocessing at any 
time.

Furthermore, OpenLAB CDS ChemStation Edition in combination with ECM 
offers features that enable users to comply with 21 CFR Part 11 and similar 
regulations for electronic records and electronic signatures:

• Mandatory login/connection to ECM

• Configurable session locking

• Configurable ChemStation user roles and privileges

• Full data traceability through audit trails for methods and results

• Full data versioning

You can use ECM in any of the installation scenarios for OpenLAB CDS 
ChemStation Edition:

• Workstation

• Networked workstation

• Distributed system

The main workflows for the transfer of raw data and methods/sequence 
templates/report templates are listed below. These workflows indicate the 
system activities in relation to the work processes.
ChemStation with ECM Concepts Guide 9



1 Introduction
Using ChemStation with ECM
Overview of data-related workflows
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Introduction 1
Using ChemStation with ECM
Workflow 1: Raw data acquisition and automatic transfer to ECM 

1 Analytical raw data is acquired using ChemStation.

2 The raw data is automatically uploaded to ECM using the configured path 
definitions immediately after the single run/sequence is finished.

3 A new ECM data set is created in the defined ECM location.

Workflow 2: Offline revision during acquisition

1 Analytical raw data is acquired using ChemStation.

2 While the acquisition is still running, part of the data is changed using an 
offline ChemStation.

3 The raw data is automatically uploaded to ECM using the configured path 
definitions immediately after the single run/sequence is finished.

A new ECM data set is created in the defined ECM location.

4 After work in the offline ChemStation is finished, the changed data is also 
automatically uploaded to ECM.

Another new version of the ECM data set is created.

Workflow 3: Reprocessing data and automatic upload to ECM

1 Existing analytical data is loaded from ECM into ChemStation.

2 The data is reprocessed in ChemStation.

3 The data is automatically uploaded to ECM. The location in ECM is defined 
by the original path definitions of the downloaded ECM data.

4 A new version of the data is created in ECM.

Workflow 4: Import after reprocessing

1 Existing analytical data is opened locally.

2 The data is reprocessed in ChemStation.

3 After reprocessing, the data is automatically uploaded to ECM. The location 
in ECM is defined by the current preferences in ChemStation.

4 A new version of the data is created in ECM.
ChemStation with ECM Concepts Guide 11



1 Introduction
Using ChemStation with ECM
Overview of workflows for methods/sequence templates/report 
templates
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Introduction 1
Using ChemStation with ECM
Workflow 1: Uploading a new method, sequence template or report 
template

1 A new method, sequence template, or report template is created.

2 The method, sequence template, or report template is uploaded to ECM 
using the path selected by the user.

3 The version 1 of the method, sequence template, or report template is 
automatically created in ECM.

Workflow 2: Saving a changed method, sequence template or report 
template

1 An existing method, sequence template, or report template is loaded from 
ECM.

2 The changed method, sequence template, or report template is saved to 
ECM.

3 A new version of the method, sequence template, or report template is 
automatically created in ECM.
ChemStation with ECM Concepts Guide 13



1 Introduction
Data Storage in ECM
Data Storage in ECM

ECM provides a four-level data storage model with the structure of Location, 
Cabinet, Drawer, Folder. The Location, Cabinet, Drawer and Folder names 
comprise the path name (called either LCDF path or Remote Data Path) of the 
storage location. Data is stored at Folder level only. 

The ECM program’s content structure is similar to rooms filled with file 
cabinets. Each cabinet has multiple drawers, which then contain hanging 
folders. Finally, paper files are stored in the folders. The LCDF structure can 
be created using the ECM Web Client. In addition, it is possible to create 
additional Locations, Cabinets, Drawers, and Folders using the ChemStation 
Remote Data Path. In ChemStation, it is also possible to set predefined tokens 
for the Drawers and Folders.

In the ECM tree view, locations are denoted by a house icon. Inside each 
Location, Cabinets are denoted by the file cabinet icon. Inside each Cabinet, 
Drawers are denoted by the drawer icon. Finally, inside each Drawer, Folders 
are denoted by the folder icon. The entire content structure appears in the 
Content book.

Figure 1 LCDF structure in ECM

Uploaded objects can be stored in the lowest (i.e. Folder) level only. It is not 
possible to upload data to other levels of the hierarchy.
14 ChemStation with ECM Concepts Guide



Introduction 1
21 CFR Part 11 Compliance
21 CFR Part 11 Compliance

Effective August 20, 1997, the U.S. Food and Drug Administration (FDA) 
released and published a new rule to enable pharmaceutical companies to 
approve their results with electronic signatures and to transfer paper-trail 
documentation into electronic records. This rule is known as 21 Code of 
Federal Regulations Part 11 (referred to as 21 CFR Part 11) and applies to all 
industry segments regulated by the FDA.

21 CFR Part 11 includes the US Federal guidelines for storing and protecting 
electronic records and applying electronic signatures. The intent of these 
guidelines is to ensure that electronic records subject to these guidelines are 
reliable, authentic, and maintained with high integrity.

OpenLAB CDS ChemStation Edition in combination with Agilent OpenLAB 
ECM provides the necessary controls for managing system access, audit trail 
functions, versioning of ChemStation data, and electronic signature functions. 
Agilent OpenLAB ECM ensures secure record keeping and data archival. 
Agilent OpenLAB ECM is proven and has been deployed at many leading life 
sciences companies to satisfy compliance mandates for 21 CFR Part 11.
ChemStation with ECM Concepts Guide 15
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2 Basic Concepts of ChemStation with OpenLAB ECM
Login and Lock Options
Login and Lock Options

User Permissions

You start ChemStation from the OpenLAB Control Panel. To prevent 
unauthorized access, the OpenLAB Control Panel requires authentication 
with a user name and password. As the OpenLAB Control Panel uses ECM as 
an external authentication provider, you log in with your ECM user 
credentials.

You need specific user privileges for working with OpenLAB CDS as well as for 
working with OpenLAB ECM. The privileges set in the OpenLAB Control Panel 
define which functions you can use in ChemStation, and also which 
administrative tasks you can carry out in the OpenLAB Control Panel. The 
privileges set in ECM define the accessible content and functions in ECM. For 
more information on user privileges, see “Users/Groups/Roles 
Configuration” on page 73.

User Credentials

User credentials

The Login dialog requires you to enter a set of valid authorization details in 
order to log in to the OpenLAB Control Panel.

You need to enter the following login details:

• Login: the user name defined in the Shared Services, or your NT domain 
user name (depending on the user configuration in the Shared Services)

• Password: the password provided by your administrator, which can be 
changed on request (for 'built-in' users), or the password of your NT domain 
account, if you are logging in using your NT domain user name.

• Domain: the domain administrating the users
18 ChemStation with ECM Concepts Guide



Basic Concepts of ChemStation with OpenLAB ECM 2
Login and Lock Options
ChemStation Operator and ECM User

With ECM as an authentication provider, the ChemStation operator name in 
the sample info (when running single samples) or the sequence parameters 
(when running a sequence) is overwritten by your ECM user name. The 
operator name cannot be overwritten. Therefore, you cannot change the user 
with the Change User ... command while acquiring data. This prevents the 
operator name from being changed during data acquisition.

Session lock

If you leave the ChemStation computer for a certain period of time, you can 
lock ChemStation so that no other user can access the program. This is a 
safety feature to ensure that there is no unauthorized access to ChemStation. 
When you activate the session lock, you or another user must first provide a 
valid login before continuing to work with ChemStation.

In ChemStation, there are the following options to activate the session lock:

• Privately (User > Lock Session > privately): Only the user who activated the 
session lock, or a user with the Break Session Lock privilege, can log in.

• Non-privately (User > Lock Session > non privately): Any valid user can log in. 
This is useful, for example, if there is a shift change, and the leaving 
personnel secures ChemStation until the personnel of the new shift starts 
work.

• Toolbar lock button: The toolbar lock button can be configured to lock the 
ChemStation session privately or non privately.

• Time-based: Depending on the Shared Services configuration, ChemStation 
is automatically locked after a given period of time without any user 
interaction (Inactivity Timeout setting in the Security Policy area of the 
OpenLAB Control Panel).

The time-based session lock can be configured to lock the ChemStation 
session either privately or non-privately (see “ChemStation Administration 
Tool” on page 78).
ChemStation with ECM Concepts Guide 19



2 Basic Concepts of ChemStation with OpenLAB ECM
OpenLAB ECM User Interface in ChemStation
OpenLAB ECM User Interface in ChemStation

Overview of the interface elements

When connected to ECM, the following new menus, menu items, and interface 
elements are available in ChemStation:

Menu Element type Description

Method Enable Audit Trail 
Command

See “Method Audit Trail” on page 64

Sequence > Sequence Parameters Sequence Parameters Tab See “Remote Data Path as Sequence 
Parameter” on page 33

Report Report History Command See “Report History” on page 66

View > Preferences Tabs In the Preferences 
dialog:
• Transfer Settings
• Audit Trail

See “ECM Preferences” on page 23 and “Audit 
Trails and Logbooks” on page 64

ECM ECM Menu See “The ECM menu” on page 21

User User Menu See “The User menu” on page 22

Toolbar (depending on the current view) • Shortcuts to several 
commands of the ECM 
and User menus

• LCDF info

• LCDF info in the Data Analysis view: shows 
the LCDF path of a file that has been stored 
to ECM.

• LCDF info in the Method and Run Control 
view: shows the LDCF path for automatic 
upload after acquisition.

ECM related details in the System 
Diagram in Method and Run Control view 
(classic UI only).

Details view The following details are available:
• LCDF
• Operator
• Automatic transfer after acquisition
• Automatic transfer after reprocessing
• Automatic transfer after any data 

modification
• Automatic import after reprocessing
20 ChemStation with ECM Concepts Guide



Basic Concepts of ChemStation with OpenLAB ECM 2
OpenLAB ECM User Interface in ChemStation
The ECM menu

The ECM menu and its commands depend on the view that is currently active. 
See the following table for details.

NOTE There is no ECM menu in the Verification (OQ/PV) or Diagnosis view.

Command Description Available in ChemStation views

Update Methods ...
Update Sequences Templates ...

Update all methods/sequence templates that are 
stored in the local file system with the current 
version from ECM (if existing in ECM). Local 
changes are overwritten.

• Method and Run Control

Update Report Templates ... Update all report templates that are stored in the 
local file system with the current version from 
ECM (if existing in ECM). Local changes are 
overwritten.

• Report Layout

Cleanup Data The Cleanup Data command deletes all data or 
result sets from the local file system that exist in 
ECM as well. Make sure you uploaded the latest 
version to ECM before you confirm this command. 
See “Cleanup Data on Shutdown” on page 28.

• Data Analysis

Manage Queue With the Manage Queue command you can 
continue any interrupted data upload to ECM. See 
“Manage Queue on Connect” on page 27.

• Method and Run Control
• Data Analysis

Preferences
See “ECM Preferences” on page 23 for more 
details on the Preferences dialog.

• Method and Run Control
• Data Analysis
• Report Layout

Method-related commands:

Load Method ...

Save Method

See “Workflows for Methods and Templates” on 
page 50

• Method and Run Control
• Data Analysis
ChemStation with ECM Concepts Guide 21



2 Basic Concepts of ChemStation with OpenLAB ECM
OpenLAB ECM User Interface in ChemStation
The User menu

Data-related commands:

Load Data ...

Save Data

Save Data As ...

See “Data-related workflows” on page 39 • Data Analysis

Commands related to the sequence 
template:

Load Sequence Template ...

Save Sequence Template

See “Workflows for Methods and Templates” on 
page 50

• Method and Run Control

Commands related to report 
templates:

Load Report Template

Save Report Template

See “Workflows for Methods and Templates” on 
page 50

• Report Layout

Commands related to reports:

Load Report Template

Save as PDF

Save as XLS

• You can load a specific report template from 
ECM. 

• You save the report generated with this 
template as a PDF or XLS file to ECM.

• Review

Command Description Available in ChemStation views

Command Description Available in ChemStation views

Change User ... Log in as a different user (only affects the 
ChemStation login, not the OpenLAB Control 
Panel login).

• Method and Run Control
• Data Analysis
• Review
• Report Layout

Lock Session • privately
• non privately
See “Session lock” on page 19.

• Method and Run Control
• Data Analysis
• Review
• Report Layout
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Basic Concepts of ChemStation with OpenLAB ECM 2
ECM Preferences
ECM Preferences 

The Preferences dialog contains two tabs that are relevant to OpenLAB ECM: 
the Transfer Settings tab and the Audit Trail tab.

On the Transfer Settings tab, you must specify the following preferences in order 
to automatically store ChemStation data to ECM:

• Remote Data Path

• Automatic Data Transfer Settings

• Transfer Management Settings

Figure 2 Transfer Settings tab in the Preferences dialog

All of these items can be specified independently for each instrument. Offline 
and online sessions are automatically synchronized. 

NOTE You can change these settings for all ChemStation instances on the client PC in one single 
step by using the ChemStation Administration Tool (see “ChemStation Administration 
Tool” on page 78). If settings have been specified for all ChemStation instances on the 
computer, you cannot change the settings in the Preferences dialog.
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2 Basic Concepts of ChemStation with OpenLAB ECM
ECM Preferences
On the Audit Trail tab, you can enable the Method Audit Trail and Results Audit 
Trail. For details on audit trails see “Audit Trails and Logbooks” on page 64.

Figure 3 Audit Trail tab in the Preferences dialog

Remote Data Path

The Remote Data Path needs to be specified in order to save the data to the 
correct location in ECM. 

In the Preferences dialog, the Transfer Settings tab (see Figure 3 on page 24) 
allows you to define the Remote Data Path. The Remote Data Path reflects the 
LCDF structure in ECM.

Server/Account

In the text fields Server and Account, you can specify the ECM Server and ECM 
Account that you want to use to store the ChemStation data.

At your first login from ChemStation to ECM, you must specify the server and 
account information. You can either enter the information manually, or you 
can click Get Server to fill the fields with the Server and Account where you are 
24 ChemStation with ECM Concepts Guide



Basic Concepts of ChemStation with OpenLAB ECM 2
ECM Preferences
currently logged in. ChemStation then keeps the Server and Account 
information for future sessions.

If you log in to a different ECM Server later, you have to update the Server and 
Account information. You can click Get Server again to fill the fields with the 
current ECM Server name and the current ECM Account.

Path

To specify the Remote Data Path, you need to select a Location and Cabinet 
available in the ECM Browser. Click Select Path to select the required path in 
an ECM Explorer dialog.

For the Drawer and Folder, you can either keep the selected items, or you can 
select predefined tokens for an automatic path creation. When you use the 
predefined tokens in the Remote Data Path, the system automatically creates 
the items if they do not already exist in ECM. 

Alternatively, the Remote Data Path can be specified as Sequence Parameter (see 
“Remote Data Path as Sequence Parameter” on page 33). Uploaded objects can 
be stored only at the Folder level.

NOTE If no Remote Data Path is specified, a warning message will be shown at ChemStation 
startup.

NOTE If you use tokens, make sure you have the required ECM privileges to create folders! 
Alternatively, another user who has the required privileges can create the necessary folders 
in advance.
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2 Basic Concepts of ChemStation with OpenLAB ECM
ECM Preferences
Automatic Data Transfer Settings

In the Preferences dialog (View > Preferences), the ECM tab allows you to specify 
the automatic settings for the transfer of raw data. The transfer settings, as 
well as the Remote Data Path, are used to automatically upload data to ECM. 

After Acquisition

If you select this check box the data is automatically uploaded to ECM after an 
acquisition. The raw data files are written to the local ChemStation file system 
while the sequence is still running. When the complete sequence is finished, 
the raw data files are compressed to an SSIZip file which is then uploaded to 
ECM. 

For more information, please refer to “Workflow 1: Acquisition and automatic 
upload” on page 39.

Table 1 Remote Data Path items

ECM Data Path Item Convention

Location Fixed location
to be selected in ECM

Cabinet Fixed cabinet
to be selected in ECM

Drawer Drawer available in ECM
Tokens: Instrument Name, Instrument Number, Operator

Folder Folder available in ECM
Tokens: Instrument Name, Instrument Number, Operator

NOTE If you are not logged in to ECM in ChemStation, the data cannot be automatically uploaded 
to ECM as specified in the transfer settings. The data is then queued in the Spooler Queue 
Manager (see “Spooler Queue Manager” on page 29).

NOTE If you perform data acquisition from the Diagnosis view or OQ/PV view, the transfer 
settings are ignored. The analytical raw data is written to the ChemStation data file system 
as predefined in the diagnosis or verification methods.
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Basic Concepts of ChemStation with OpenLAB ECM 2
ECM Preferences
After Any Data Modification

If you select this check box, the result set is automatically uploaded to ECM 
after you changed the data analysis parameters for a sample. The data is 
uploaded even if you do not reprocess the sequence.

For more information, please refer to “Workflow 2: Offline review during 
acquisition” on page 42.

After Reprocessing

If you select this check box, the result set is automatically uploaded to ECM 
each time after you reprocessed the sequence.

For more information, please refer to “Workflow 3: Reprocessing data and 
automatic upload” on page 44.

Import after Reprocessing

If you select this check box, a sequence that is only stored locally is 
automatically uploaded to ECM after reprocessing.

For more information, please refer to “Workflow 4: Import after 
reprocessing” on page 48.

Transfer Management Settings

Manage Queue on Connect

If the connection to ECM breaks down for any reason, a running data upload 
might be interrupted. In this case, the remaining data is written to an internal 
queue. 

If you select the check box Manage Queue on Connect, ChemStation tries to 
upload the remaining data to ECM each time a connection to ECM is 
established (that is, each time a user logs on to ECM from ChemStation).

Alternatively, you can open the Spooler Queue Manager dialog (see “Spooler 
Queue Manager” on page 29) at any time with the ECM > Manage Queue 
command in the Data Analysis view.
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2 Basic Concepts of ChemStation with OpenLAB ECM
ECM Preferences
Cleanup Data on Shutdown

If you select this check box, ChemStation checks the local file system at each 
shutdown. It deletes all local data and sequence files that are known to be 
stored in ECM as well. Methods and sequence templates remain on the local 
file system.

Alternatively, you can open the Data Cleanup dialog at any time with the ECM > 
Cleanup Data command in the Data Analysis view.

This dialog box lists all data sets related to ECM apart from the currently 
loaded data. The following columns are available:

• Directory: Location of the local file

• ECM Information: ECM server, account information, and LCDF path of the file 
in ECM

• Last Modified: Date/Time when the copy in ECM was last changed

• Locally Modified: Information whether the local copy has been modified

• Local Version: Version that was downloaded to the local directory

You can now manually select the data sets to be deleted from the local disk.

Alternatively, via a drop down list deselect all data sets, select all, select only 
single runs, select only result sets, select items older than today, or items older 
than a week.

After pressing OK, the local copies of the selected data sets are deleted.

NOTE If you select the Cleanup Data on Shutdown check box, you should also select the 
Automatic Data Transfer Settings After Acquisition, After Reprocessing, and After Any 
Data Modification. Otherwise, if the users forget to upload the data to ECM before closing 
ChemStation, data might be lost.

NOTE Consider selecting the Cleanup Data on Shutdown check box when the system shall be 
compliant to 21 CFR Part 11. Using this function prevents unauthorized access to the local 
data files.
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Basic Concepts of ChemStation with OpenLAB ECM 2
ECM Preferences
Both automatic cleanup on shutdown and manual cleanup are only possible if 
the following conditions are fulfilled:

• the ChemStation user is logged on to ECM

• no other instance of the ChemStation instrument is open

• the spooler queue is empty

If one of these conditions is not fulfilled, automatic cleanup will not be 
performed and it is not possible to open the Data Cleanup dialog.

Spooler Queue Manager

The Spooler Queue Manager dialog is opened via ECM > Manage Queue. If you 
selected the check box Manage Queue on Connect, and there are interrupted 
transfers, the dialog is also opened when you start ChemStation.

With this dialog, you can manage the data transfers from ChemStation to ECM 
that were interrupted or could not be started for any reason. Each failed 
transfer job is listed in a separate line.

Figure 4 Spooler Queue Manager

The following information is provided for each line:

• Description: Information on the version of the data that will be transferred. 
Two values are possible:

• Import: No older version of the data exists in ECM at this time. The data 
has been newly created and will be uploaded as Version 1. 

• Commit: There is already at least one version of the data in ECM. The 
version number of the uploaded data will be increased by one.

• Error: Error that disrupted the data transfer. For details on the possible 
errors, see “Error Messages in the Spooler Queue Manager” on page 99.
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• Queued at: Date when the unsuccessful transfer was queued in the Spooler 
Queue Manager.

• Processed last at: Date when the transfer was last attempted.

The toolbar offers you the following commands to manage the queue:

When items are selected from the queue or saved to the local disk, an audit 
trail entry will be added to Audit Trail of ECM.

Table 2 Queue management toolbar

Icon Tooltip Description

Process queue Continue processing the transfer jobs. As long as there 
is no error, all pending transfer jobs will be processed in 
the order as they are shown in the list. This function is 
only active if you select the first line in the list. 

Stop processing Stop processing the transfer jobs.

Save selected item locally Save the selected lines to a file. 
Only the displayed error, description, and dates are 
saved to the file. The respective data is not included!

Delete selected item Delete the selected transfer job from the queue. The 
concerned data will not be transferred to ECM. 

Properties Display the Queue Management dialog box, which 
shows details of the items in the queue in either 
summary or detailed form.

Refresh view Update the display of the items in the list.

NOTE When items are deleted from the queue or saved to the local disk, they have not yet been 
uploaded to ECM.
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Queue Management Details Dialog Box

The Queue Management Details dialog box is displayed when you click the  
tool in the toolbar of the Queue Management dialog box. It shows the 
command-specific details of the commands in the Queue Management dialog 
box. The Queue Management Details tabs offer two views of the command 
details:

• Summary tab

• Details tab

In either tab, the tools in the toolbar allow you to navigate through the 
command details: 

Summary tab

The Summary tab gives the following summary information about the selected 
item:

Displays the details of the first command in the list.

Displays the details of previous command in the list.

Displays the details of next command in the list.

Displays the details of last command in the list.

Command Description The description of the item.

 Created The date and time when the item was added to the queue.

Changed The date and time when the item was last processed.

Last Error A description of the error that caused the item to be added to the queue.
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Details tab

The Details tab gives detailed information about the selected item. You cannot 
edit the information in this list. The toolbar provides the following tools:

Sorts the properties by category.

Sorts the properties alphanumerically.

This tool is disabled under all circumstances in the ChemStation.
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Remote Data Path as Sequence Parameter

Instead of specifying the Remote Data Path in the Preferences for all acquisition 
sequences to be run (see “Remote Data Path” on page 24), the remote data 
path can also be set directly in the sequence template. This allows to set up 
different remote paths for each sequence without having to modify the 
Preferences. The Remote Data Path for a sequence template is set up in the 
Sequence Parameters tab.

Figure 5 Sequence Parameters tab of the Sequence Parameters dialog

Use Preferences: When this checkbox is enabled, the Remote Data Path as 
specified in the Preferences will be used. Any LCDF path specified in the 
Sequence Parameters will be ignored for this sequence. When this checkbox is 
disabled, the Remote Data Path will be used as specified when the sequence 
template is used for data acquisition. 
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Path: To specify the Remote Data Path, you need to select a Location and Cabinet 
available in the ECM Browser. Click Select Path to select the required path in 
an ECM Explorer dialog. For the Drawer and Folder, you can either keep the 
selected items, or you can select predefined tokens for an automatic path 
creation. When you use the predefined tokens in the Remote Data Path, the 
system automatically creates the items if they do not already exist in ECM.

NOTE If you use tokens, make sure you have the required ECM privileges to create folders! 
Alternatively, another user who has the required privileges can create the necessary folders 
in advance. 
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Compressed ChemStation File Formats

When ChemStation data is uploaded to ECM, the data is automatically 
packaged into an SSIzip file. Depending on the type of data, different 
packaging formats are used. 

The packaging of ChemStation items is part of OpenLAB CDS ChemStation 
Edition and cannot be changed manually.

The packaging is automatically carried out when the data is uploaded to ECM. 
When the SSIZIP files are downloaded from ECM to ChemStation, they are 
automatically unpacked into the according directory in the ChemStation 
Explorer.

ChemStation data Packaging format Icon in 
ChemStation

Single Runs
(*.d file, *.rdl files, and DA.M) 

*.D.SSIZIP

Result set
The result set contains recursively the whole 
sequence data stored in the sequence 
subdirectory:
• all *.d files along with DA.M
• all methods *.m used during acquisition
• batch file *.b
• sequence logbook file *.log
• all *.rdl files used for sequence summary 

reports and single injection reports

*.SC.SSIZIP

Methods *.M.SSIZIP

Sequence templates *.S or
*.S.SSIZIP
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This chapter describes the basic workflows for ChemStation with ECM. There 
are four data-related workflows and two workflows for methods, sequence 
templates, or report templates.
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Transferring Data to or from ECM

You can open and save different ChemStation items into their ChemStation 
contexts:

• Methods

• Sequence templates

• Report templates

• Single run data 

• Sequence data

All of this data is stored in ECM as SSIZIP result sets (see “Compressed 
ChemStation File Formats” on page 35).

When the data is uploaded to ECM, local copies of the files still remain in the 
ChemStation file system. If an item is loaded from ECM back into 
ChemStation, it is automatically loaded into its original location.

Different options are available regarding the automatic upload of single 
run/sequence data to ECM. Loading back stored data from ECM to 
ChemStation, however, always requires a manual load action. Methods, 
sequence templates and report templates require always a manual upload to 
ECM as well as a manual load or update into ChemStation.

For downloading data from ECM, several load commands are available in the 
ECM menu. Depending on the current view, you can load different files from 
ECM. In the Data Analysis view, you can load single run data or sequence data. 
These data are automatically set to the status checked out in ECM. In the 
Method and Run Control view, you can load methods and sequence templates. 
These items are only retrieved and not checked out. If you use Intelligent 
Reporting, you can also load report templates from ECM in the Report Layout 
view. 

The following workflows are examples that represent typical tasks done with 
ChemStation and OpenLAB ECM.
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Workflow 1: Acquisition and automatic upload

Figure 6 Acquisition and automatic upload
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The workflow Acquisition and automatic upload illustrates how raw data is 
uploaded to ECM directly after the acquisition is finished. The raw data is 
initially stored locally. After completing the acquisition, the data is 
automatically uploaded to ECM. 

To save data to ECM automatically after completion of a single run or 
sequence:

1 Log in to the OpenLAB Control Panel and launch an online ChemStation.

2 Load a sequence template.

Your ECM user name is automatically inserted as operator name into the 
sequence template.

3 In the Data Analysis view, click View > Preferences.

4 On the Transfer Settings tab, configure the following settings:

• Remote Data Path: Select the ECM location that you want to use for the 
sequence data upload.

• Select the After Acquisition check box.

5 Configure the sequence parameters and the sequence table.

6 Start the acquisition.

While the acquisition is running, the raw data, method definition, and a 
copy of the sequence template are locally stored on the ChemStation 
computer.

After the sequence is finished, all data is automatically uploaded as an 
.SC.SSIZIP file to ECM to the previously defined LCDF path. The local copy 
of the data remains on the ChemStation computer. The file name of the 
result set is determined by the settings in the sequence template (for more 
details on the sequence template settings, refer to the manual 
Understanding Your ChemStation). After uploading the result set the 

sequence icon in the ChemStation Navigation Pane changes from  to . 
The LCDF path of the result set is shown in the ChemStation toolbar.

NOTE The color of the Sequence Data icon in the Navigation Pane allows to track the 
modification status of the data:

: The result set is stored in ECM and has not been modified locally

: The result set is stored in ECM and has been modified locally
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NOTE The upload process may take some time when large amounts of data are uploaded. During 
this time ChemStation is busy and the user cannot perform tasks in ChemStation. Please 
wait until the upload is completed.
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Workflow 2: Offline review during acquisition

Figure 7 Offline review during acquisition

The workflow Offline revision during acquisition illustrates how raw data is 
reviewed while the acquisition is still running. Directly after the acquisition is 
finished, the original raw data is automatically uploaded to ECM. After the 
review, the changed data is again uploaded to ECM. When the data is uploaded 
the second time, a new version is created.
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To save data to ECM automatically after changing the data:

1 Log in to OpenLAB Control Panel and launch an online ChemStation.

2 Load a sequence template. 

Your ECM user name is automatically inserted as operator name into the 
sequence template.

3 In the Data Analysis view, click View > Preferences.

4 On the Transfer Settings tab, configure the following settings:

• Remote Data Path: Select the ECM location that you want to use for the 
sequence data upload.

• Select the After Acquisition check box.

• Select the After Any Data Modification check box.

5 Start the acquisition.

While the acquisition is running, the raw data, method definition, and a 
copy of the sequence template are stored locally on the ChemStation 
computer.

6 Open an offline ChemStation and change some data analysis parameters for 
one of the already finished samples. Save your changes locally.

7 After the acquisition has been finished, two things will happen:

• The original raw data is automatically uploaded as an .SC.SSIZIP file, 
Version 1, to ECM to the previously defined LCDF location. The LCDF of 
the new sequence is shown in the toolbar in the online ChemStation.

The file name of the result set is determined by the settings in the 
sequence template (for more details on the sequence template settings 
refer to the manual Understanding Your ChemStation). 

The sequence icon in the ChemStation Navigation Pane changes from  

to .

• The ECM forced upload dialog opens in the online ChemStation. Click OK to 
confirm that you finished all work in the offline instance. As soon as you 
confirm this dialog, the changed data is uploaded as Version 2 to ECM.

A local copy of the changed data remains on the ChemStation computer. 

NOTE For both versions (the one after acquisition and the one from the parallel offline review) the 
ECM operator is the user who has run the acquisition, even if another user has performed 
the review in the Offline ChemStation.
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Workflow 3: Reprocessing data and automatic upload

Figure 8 Reprocessing data and automatic upload

The workflow Reprocessing data and automatic upload illustrates how data 
is reprocessed and then automatically uploaded. This workflow applies to data 
that has been previously stored in ECM. A new version of the data is created 
in ECM for the reprocessed or changed data.
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To save data to ECM automatically after reprocessing:

1 Log in to OpenLAB Control Panel and launch an online or offline 
ChemStation.

2 Select ECM > Load Data to download a sequence from ECM.

The ECM Desktop Open dialog opens. Navigate to the ECM folder to load the 
data of your choice and select one of the following packaged files:

• Single run data: *.D.SSIZIP files

• sequence data: *.SC.SSIZIP files

Figure 9 ECM Desktop Open dialog

If the item is checked out, it is marked with a blue or red icon (see 
marker 1):

 (blue icon): the item has been checked out by you (current user)

 (red icon): the item has been checked out by another ECM user

You can load any checked out item. However, if an item has been checked 
out by another ECM user, the other user must check in the item before you 
can save it back to ECM.

To check out or check in an item, you can use the respective icons available 
in the ECM Desktop Open dialog (see marker 2). You can only check out the 
latest version of an item.

In order to see more details regarding the type and version of the available 
items, select the Detail view (see Figure 9 on page 45, marker 3). To open an 
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older version of an item, select the Open Revisions command from the Open 
menu (see Figure 10 on page 46). This opens the File Versions dialog, where 
all available versions of the item are listed (see Figure 11 on page 46).

Figure 10 Open Revisions command

Figure 11 File versions dialog
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3 Select Open in either dialog to download the item to ChemStation. 

If the item was not already checked out, it is automatically checked out of 
ECM when you load it to ChemStation.

The LCDF path of the data is shown in the ChemStation toolbar.

4 In the Data Analysis view, click View > Preferences.

5 On the Transfer Settings tab, configure the following settings:

• Select the After Reprocessing check box.

• Select the After Any Data Modification check box.

6 Modify or reprocess the sequence data.

After the reprocessing is finished, the sequence data is uploaded with its 
original name to its original LCDF path. The version number is increased by 
one.

The local copy of the reprocessed data remains on the local file system of 
the ChemStation computer.
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Workflow 4: Import after reprocessing

Figure 12 Import after reprocessing

The workflow Import after reprocessing illustrates how locally saved data is 
reprocessed and then automatically imported in ECM. 
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To save data to ECM automatically after reprocessing:

1 Log in to OpenLAB Control Panel and launch an offline ChemStation.

2 From the local file system, open a sequence that has never been saved to 
ECM before.

3 In the Data Analysis view, click View > Preferences.

4 On the Transfer Settings tab, configure the following settings:

• Remote Data Path: Select the ECM location that you want to use for the 
sequence data upload.

• Select the Import after Reprocessing check box.

5 Reprocess the sequence data.

The sequence data is uploaded as a new .SC.SSIZIP file, version 1, to the 
previously defined LCDF path in ECM. The file name of the result set is 
determined by the settings in the sequence template (for more details about 
the sequence template settings refer to the manual Understanding Your 
ChemStation).

The sequence icon in the ChemStation Navigation Pane changes from  to .

The local copy of the reprocessed data remains on the local file system of the 
ChemStation computer.

NOTE The data will not be uploaded if you only modify it. You need to reprocess the sequence 
data.
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Workflows for Methods and Templates

The following workflows are applicable to methods and sequence templates. If 
you enabled Intelligent Reporting in Instrument Configuration in the 
OpenLAB Control Panel, these workflows also apply to report templates. The 
diagrams show the workflows using methods as an example.
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Workflow 1: Local files – Save new method

Figure 13 Local files - Save new method

The workflow Local files - Save new method illustrates how newly created or 
locally stored methods or sequence template can be manually uploaded to 
ECM.
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To upload a new method, sequence template, or report template:

1 Log in to OpenLAB Control Panel and launch an offline ChemStation.

2 In ChemStation, load the method/sequence template/report template or 
create a new one.

3 Select the appropriate Save command.

In the Method and Run Control view:

• ECM > Save Method

• ECM > Save Sequence Template

In the Report Layout view:

• ECM > Save Report Template

The ECM Save dialog opens.

4 Navigate to the Remote Data Path of your choice to upload the 
method/sequence template/report template. 

You can only upload items into a Folder, not into a Location, Cabinet, or 
Drawer.

5 If necessary, save the item using a different name. the original name is used 
by default, but you can modify the name.

6 Click Save.

The Add File dialog opens. 

7 Enter a reason for the upload and click OK. The reason is then shown in the 
ECM Audit Trail (see “ECM Audit Trail” on page 67).

The progress of the upload is displayed in a window until the item is 
uploaded to ECM. 

After finishing the upload, the SSIZIP file is available in ECM as version 1. 
The file is saved to the Remote Data Path defined in the Preferences (see 
“Remote Data Path” on page 24). 

The method icon in the ChemStation Navigation Pane changes from  to 

.

The icon for a sequence template changes from  to .

The icon for report templates changes from  to 
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Workflow 2: ECM – Save changed method

Figure 14 ECM - Save changed method

The workflow ECM - Save changed method illustrates how methods, sequence 
templates, or report templates that are already stored in ECM are edited and 
saved under the same name as a new version.
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1 Log in to OpenLAB Control Panel and launch an online or offline 
ChemStation.

2 Load a method, sequence template, or report template.

• Open a method/sequence template/report template from your local PC. 
Choose an item that has been uploaded to ECM before. ECM Methods are 

indicated by , ECM sequence templates by , and ECM report 

templates by  in the ChemStation Navigation Pane.

– or –

• Select ECM > Load Method, ECM > Load Sequence Template, or ECM > Load 
Report Template respectively to download an item from ECM.

If you use one of the Load commands, the ECM Desktop Open dialog will open. 
Navigate to the ECM folder to load the method (*.M.SSIZIP) or sequence 
template (*.S or *.S.SSIZIP) of your choice.

Figure 15 ECM Desktop Open dialog

If the item is checked out, it is marked with a blue or red icon (see Figure 15 
on page 54, marker 1):

 (blue icon): the item has been checked out by you (current user)

 (red icon): the item has been checked out by another ECM user
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You can load any checked out item. However, if an item has been checked 
out by another ECM user, the other user must check in the item before you 
can save it back to ECM.

To check out or check in an item, you can use the according icons available 
in the ECM Desktop Open dialog (see Figure 15 on page 54, marker 2).With 
these icons, you can only check out the latest version of an item.

In order to see more details regarding the type and version of the available 
items, select the Detail view (see Figure 15 on page 54, marker 3). To open 
an older version of an item, select the Open Revisions command from the 
Open menu (see Figure 16 on page 55, marker 1). This opens the File Versions 
dialog, where all available versions of the item are listed (see Figure 17 on 
page 56).

Figure 16 Open Revisions command
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Figure 17 File versions dialog

3 Select Open in either dialog to download the item to ChemStation. In order 
to prevent other users from modifying the item, it is possible to select the 
Open As Checked Out command to mark the item as checked out from ECM 
(see Figure 16 on page 55, marker 2).

If the file already exists on the ChemStation computer in the specified 
location, you must choose a different download location.

The LCDF path of methods and sequence templates is shown in the 
ChemStation toolbar in ChemStation.

4 Make the required changes to the loaded item.

A modified method is indicated by  in the Navigation Pane.

A modified sequence template is indicated by .

A modified report template is indicated by .

5 Select the appropriate Save command to save the changed item.:

• ECM > Save Method

• ECM > Save Sequence Template

• ECM > Save Report Template

NOTE Unlike data files, the methods, sequence templates, and report templates are not 
automatically checked out of ECM! In order to modify those items in ChemStation, you 
should check them out from ECM manually. Otherwise, there is no guarantee that you are 
working on the latest version.
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6 When the Add File dialog opens, enter a reason for the upload and click OK. 
The reason is then shown in the ECM Audit Trail (see “ECM Audit Trail” on 
page 67).

The progress of the upload is displayed in a window until the item is 
uploaded to ECM. 

The .M.SSIZIP/.S file is uploaded with its original name to its original LCDF 
path (the path is shown as a tooltip of the method/sequence 
template/report template in ChemStation). The version number is 
automatically increased by one.

Updating the Local Master Method, Sequence Template, or Report 
Template

If a master method, sequence template, or report template is updated in ECM 
(i.e. a new version is created), it is possible to update the local copy with the 
following update procedure.

1 Make sure the master method, sequence template, or report template to be 
updated is currently not loaded. A currently loaded item is not available for 
update.

2 Select the appropriate Update command:

• ECM > Update Methods ...

• ECM > Update Sequence Templates ...

• ECM > Update Report Templates ....

NOTE If you have not checked out the item before loading it from ECM, and another ECM user has 
checked out the item in the meantime, you cannot proceed with the upload back to ECM. A 
warning message is displayed, and it is not possible to save the item back to ECM until the 
other user has released the checked out item.
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Figure 18 Update Methods dialog box

The Update from ECM dialog box is displayed.

The dialog box lists all items that are connected to ECM. The following 
columns are available:

• Name: Path and Name of the local copy of the method, sequence template, 
or report template.

• ECM Information: ECM server, account information, and LCDF path of the 
file in ECM.

• Locally Modified: A check box indicating whether the local copy was 
modified.

• Local Version: Version number of the local copy of the method, sequence 
template, or report template.

• ECM Version: Version number of the file in ECM.

3 You can now manually select the items that are to be updated. Alternatively 
you can via the drop down list deselect all items, select those items with a 
higher version number in ECM, or select all items that have been modified 
locally. 

After pressing OK, the selected items are updated with the version in ECM.
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Introduction to 21 CFR Part 11

Effective August 20, 1997, the U.S. Food and Drug Administration (FDA) 
released and published a new rule to enable pharmaceutical companies to 
approve their results with electronic signatures and to transfer paper-trail 
documentation into electronic records. This rule is known as 21 Code of 
Federal Regulations Part 11 (referred to as 21 CFR Part 11) and applies to all 
industry segments regulated by the FDA.

The impact of this rule on current work practices and data handling in the 
pharmaceutical industry has been much higher than expected. “The industry 
wanted to have a rule on electronic signatures, but what they got was a rule 
on electronic records.” (Martin Browning, former FDA inspector, during a 
validation seminar in Washington D.C.)

21 CFR Part 11 places high emphasis on the implementation of all measures to 
protect and secure electronic records. Notwithstanding the uncertainties and 
the changes that 21 CFR Part 11 requires in the behavior of both the 
pharmaceutical industry and the vendors of chemical analysis equipment, it is 
well worth implementing in today’s laboratories because it can help the 
industry with one of the most important issues in pharmaceutical 
research-bringing new drugs on the market faster.

The major benefits of this shift towards electronic data management are in the 
potential productivity increase for the industry. The industry can decrease its 
data output on paper, speed up the data review and approval process, and 
benefit from new automation technology based on computerized system 
control, for example, in manufacturing or dissolution drug release testing.

In addition to this rule on electronic records, other general requirements for 
computerized systems are brought to the auditor’s attention. These rules cover 
the basic requirements of validation which are limiting data access and 
ensuring data integrity and data traceability. 

It is, of course, the industry that must ensure that its work practices support 
the FDA rules, but most of the requirements also affect the chemical analysis 
systems and suppliers of these systems.
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21 CFR Part 11 Requirements

To fulfill the FDA rules and guidelines for compliant electronic records and 
computerized systems, it is important to understand the basic aspects of 
secure data handling.

• Data security: physical protection of data by limiting access to the system 
and preventing unauthorized access.

• Data integrity: protecting raw data and metadata and preventing these 
from unauthorized modification, and linking raw data and results to 
reproduce the original results at any time, for example, in an audit 
situation, and document each new result copy.

• Audit traceability: documenting who did what to the results and when, and 
tracing the user adding new reanalyzed versions to the original raw data.

General Aspects of Data Security in Computerized Networks - Open 
Versus Closed Systems

Before discussing details of data security in a chromatographic system, some 
general aspects of data security in a computerized network need to be 
considered.

It is generally known that data transfer over a public network can be accessed 
by unauthorized external persons, "hackers", who gain access either for 
personal amusement or intentional fraud. 

If an electronic identification comprising user ID and a password is used to 
approve confidential or important data, users must be sure that their 
signatures are unbreakably linked to the data and that nobody can copy this 
signature or get access to the passwords. In a public system, this would 
require additional encryption technology, for example, a private/public key 
combination of data encryption. In contrast, if a computerized system is 
protected from unauthorized access, users can be sure that their signatures 
are private and are not accessible to unauthorized individuals.

The FDA also distinguishes between these two scenarios and defines them as 
open and closed systems. A public network system can therefore only be 
viewed as an open system and a protected network as a closed system, if it 
fulfills additional requirements.
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In FDA terms, "closed system means an environment in which access is 
controlled by persons who are responsible for the content of electronic 
records on the system" (11.3.5). The evidence of a system being a closed 
system is not a one-time check but an ongoing process of executing and 
documenting the system controls that make sure that the system is closed. In 
contrast, in an open system, "those persons being responsible for the content 
of electronic records do not control the system access."

As a result, open systems require additional encryption technology for all data 
transfer over the network.

Agilent OpenLAB CDS is designed for and supported in closed systems.
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Overview of Configuration Steps Required for Part 11

If you want to configure OpenLAB CDS ChemStation Edition with ECM to be 
compliant with 21 CFR Part 11, you need to go through the following checklist:

• LCDF structure on the ECM Server prepared according to your needs

See “Data Storage in ECM” on page 14.

• Roles/Users/Groups configured in ECM and in OpenLAB Control Panel

See “Users/Groups/Roles Configuration” on page 73.

• ECM Account configuration with active audit trail and mandatory reason

See “To enable the ECM Audit Trail” on page 67.

See “Account Configuration” on page 70.

• Password policy realized in OpenLAB Control Panel (including E-mail 
Notification)

See “User-Specific Settings” on page 72.

• E-Signatures prepared (messages and privileges)

See “Using electronic signatures” on page 84.

• Automatic Data Transfer Settings and Transfer Management Settings 
activated

See “Automatic Data Transfer Settings” on page 26.

• Audit trail active for methods and results

See “Method Audit Trail” on page 64 and “Results Audit Trail” on page 66.

• Emergency Plan available, based on options of the Administration Tool

See “ChemStation Administration Tool” on page 78.
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Audit Trails and Logbooks

In order to comply to 21 CRF Part 11, ChemStation Edition offers various 
audit trails and logbooks to document all activities associated with methods, 
results, reports, or with ECM files generally. These audit trails and logbooks 
track all changes that are made to any file, including data acquisition, 
re-analysis, and long-term archiving.

The audit trails are stored in separate files, which are stored together with the 
sample or method data. The audit trail files are archived together with the 
other data in the according SSIZIP files. The ECM logbooks are available only 
directly in ECM.

Method Audit Trail

Each method has a Method Audit Trail. By default, this Method Audit Trail 
contains only the comments that you must provide each time when you save a 
method. As there is no control on the provided text, there is no guarantee that 
the method changes are reproducible.

With regards to 21 CFR Part 11, OpenLAB CDS ChemStation Edition makes it 
possible to generate a more detailed Method Audit Trail. If the function is 
activated, the Method Audit Trail contains not only the user comments, but 
also each individual changed parameter with its old and new value. All 
changeable data analysis parameters are tracked. This means that you can 
reproduce exactly which value has been changed to what, when, and by whom.
64 ChemStation with ECM Concepts Guide



Administration Regarding 21 CFR Part 11 Compliance 4
Audit Trails and Logbooks
To enable the Method Audit Trail for all methods

This is required if you want to comply to 21 CFR Part 11.

1 Select View > Preferences

2 In the Audit Trail Status dialog, select Enable Audit Trail for this method and click 
OK.

Once enabled, the Method Audit Trail cannot be disabled.

To enable the Method Audit Trail only for the currently open method

You can also activate the Method Audit Trail only for one method. This might 
be useful, for example, when you finished the development of new method and 
want to track all further changes.

1 Select Method > Enable Audit Trail

2 On the Audit Trail tab, select Enable Method Audit Trail for all methods.

To view the Method Audit Trail for the currently open method in 
ChemStation

1 Select Method > Method Audit Trail.

To remove the detailed Method Audit Trail

Once a method is enabled for the detailed audit trail, you cannot disable it 
again. The only way to get rid of an existing Method Audit Trail is to save the 
method under a different method name. In this case, the only hint in the new 
method’s audit trail is a comment about the method being based on another 
method.

NOTE You can also use the ChemStation Administration Tool to enable the Method Audit Trail for 
all methods (see “ChemStation Administration Tool” on page 78).
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Results Audit Trail

Manual integration events are not saved in the method. Therefore, the Method 
Audit Trail contains no information on manual integration events. These 
events are only saved in the data file. Nevertheless, they have an influence on 
the results. Manual integration events are therefore saved as part of the 
Results Audit Trail.

If activated, this Results Audit Trail is added to the existing Data File Logbook 
(file name RUN.LOG). By default, the Data File Logbook only contains the 
acquisition parameters and reprocessing information for each sample. The 
Results Audit Trail additionally tracks the changes of all data analysis 
parameters for a sample. 

To enable the Results Audit Trail

If you enable the Results Audit Trail, the relevant changes are tracked for all 
samples, independent of the sequence they belong to and independent of the 
user who carries out the change.

1 Select View > Preferences

2 On the Audit Trail tab, select Enable Results Audit Trail.

To view the Results Audit Trail for the loaded sample in ChemStation

1 In the Data Analysis view, select View > Current Data File Logbook.

Report History

If you create a ChemStation report, you can display the report on the screen, 
send it to a printer, or save the report as a specific file (report.pdf). These 
report outputs may easily be lost or overwritten, especially when you create 
several reports after each other.

With OpenLAB CDS, ChemStation automatically tracks any report that was 
generated. In order to reproduce an old or overwritten report, select Report > 
Report History. Here, you can see all reports created for the current data file. 
You can also export or print this history.
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ECM Audit Trail

Audit Trail is a record showing who accessed the system and what operations 
he or she performed during a given period of time.

You can view file-related, system administration, folder administration, and 
scheduler-related entries. For example, you can see when a file was added and 
who added it.

For each operation, ECM asks the user for a reason. This reason is also shown 
in the ECM Audit Trail. For automatic uploads there are default reasons given 
by the system. The reason entry may be optional or mandatory, depending on 
the ECM configuration (see “Account Configuration” on page 70). If the system 
is configured to be compliant to 21 CFR Part 11, providing a reason is 
mandatory.

To enable the ECM Audit Trail

You can enable the ECM Audit Trail only for a complete ECM Account. To 
activate the ECM Audit Trail, you must select the check box Enable audit trail for 
this account when creating a new account.

There is no possibility to activate the ECM Audit Trail afterwards for an 
existing account, or to deactivate the ECM Audit Trail again.

To view the ECM Audit Trail for a specific file

1 In ECM, right-click the respective file and select Properties from the context 
menu.

2 In the File Properties dialog, select the Audit Trail tab.

All actions related to this specific file are listed here, together with the 
date, ECM user name who performed the action, and a reason provided by 
the according user. 

NOTE If the system shall be compliant to 21 CFR Part 11, the ECM Audit Trail must be enabled.
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To view the ECM Audit Trail for all files

1 In ECM, select the Administration page.

2 In the Navigation Pane, select the Activity Log > Audit Trail node.

All actions related to any ECM file are listed here, together with the file 
name, date, ECM user name who performed the action, and a reason 
provided by the according user. 

You can search the entries, for example, for a specific date or date range, or 
for entries related to specific categories (Files, Folders, System, Scheduler, 
or Instrument). Also you can print the entries or export them to a file.

ECM System Log

The System Log is a record that shows changes to the system, including 
configuration changes, e-mail notifications, and additions or changes of 
Locations, Cabinets, Drawers, or Folders.

You can view file-related, system administration, folder administration, or 
Scheduler-related entries. For example, you can see when a Location was 
added and by whom.

The System Log is always active; you do not need to enable it.

To view the ECM System Log

1 In ECM, select the Administration page.

2 In the navigation pane, select the Activity Log > System Log node.

All general actions related to ECM are listed here, together with the date, 
ECM user name who performed the action, and a reason provided by the 
respective user. Depending on the ECM Account administration, the reason 
may be optional or mandatory (see “Account Configuration” on page 70).

You can search the entries, for example, for a specific date or date range, or 
for entries related to specific categories (Files, Folders, System, Scheduler, 
or Instrument). Also you can print the entries or export them to a file.
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System Activity Log in OpenLAB Control Panel

The System Activity Log contains information on the various events 
associated with the Shared Services or with specific instruments. You can 
filter the list in order to view only the events of a specific type, in a specific 
time range, created by a specific user, or containing a specific description.

The following types of events are recorded:

• System

• Instrument Management

• Instrument

• Project Management

• Instrument Controller

• User

• Group

• Security

• Printer

• License
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Security Policy

21 CFR Part 11 requires that the company or laboratory have a security policy 
in place to ensure that only authorized users access the data.

Account Configuration

To configure the ECM Account

1 In ECM, select the Administration page.

2 In the Navigation Pane, select the Account Administration node.

3 Double-click the Configuration item. 

The Account Administration dialog opens.
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Setting Description 21 CFR Part 11 Requirements

Lockout If a user tries too often to log in with 
invalid user credentials, he is locked out 
of the system and cannot log in any 
more – not even with valid user 
credentials. You can define the number 
of allowed login attempts.

You should limit the number of 
allowed login attempts to 
three.

Inactivity Timeout If a user does not perform any action for 
the given period of time, he is 
automatically logged out of the ECM 
Web Client.
Note: The inactivity timeout of 
ChemStation is set in the Security Policy 
area of the OpenLAB Control Panel.

You should specify a timeout.

System administrator 
email

The e-mail address you provide here will 
automatically be notified when a user 
was locked out after too many 
unsuccessful login attempts.

You should provide an e-mail 
address.

Minimum Password 
Length

If users change their passwords, they 
must choose a password with at least 
the given number of characters. The 
default setting is 5.

You should require a minimum 
password length of at least 5 
characters.

Require entry in 
Reason fields

In each ECM Audit Trail or System Log 
entry the users can enter a specific 
reason for the action. If this check box is 
selected, the entry is mandatory.

The ECM Audit Trail and 
System Log reasons must be 
mandatory.
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User-Specific Settings

1 In ECM, select the Administration page.

2 In the navigation pane, select the Account Administration node.

3 Double-click the Users/Groups/Roles item. 

The Account Administration dialog opens.

21 CFR Part 11 does not define any specific rules for the password settings. 
However, your company must have defined a password policy. You may 
consider the following settings:

• User cannot change password

• User must change password after next login

Note that the minimum password length is defined in the ECM Account 
configuration (see “Account Configuration” on page 70).
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Users/Groups/Roles Configuration

Concept of users, roles, and privileges

Users with specific roles and privileges are needed in both ECM and OpenLAB 
CDS. In ECM you can either set up internal users or operate with the Windows 
users. In OpenLAB CDS, user management is part of the Shared Services, 
which you access via the OpenLAB Control Panel. There you use ECM as an 
external authentication provider and import the ECM users.

Each user can be member of specific groups in ECM and in the OpenLAB 
Control Panel. The groups available in ECM depend on the ECM configuration. 
The groups available in the OpenLAB Control Panel can be imported from 
ECM and supplemented by new internal groups.

There are several default roles in both ECM and OpenLAB CDS. In both 
systems, you must assign a specific role to each group. You can also assign 
roles to single users. However, for the sake of clarity, it is strongly 
recommended to assign roles only on the group level. 

The roles are equipped with numerous specific privileges, which define what 
the users are allowed to view or do. Roles and privileges must be configured 
separately for ECM and ChemStation:

• The privileges set in ECM define the accessible content and functions in 
ECM. 

• The privileges set in the OpenLAB Control Panel define which functions are 
available in ChemStation, and also which administrative tasks can be 
carried out in the OpenLAB Control Panel.

NOTE Once you have created a new ECM user, group, or role, you cannot delete it again. You can 
only deactivate the unused item.
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Settings in ECM

ECM Default roles and privileges

There are a number of default roles and privileges in ECM. The following 
tables show an overview of these roles and privileges.

In addition, you can create your own roles in ECM, or grant further privileges 
to the default roles. For detailed information, refer to the ECM Administrator's 
Guide.

Assigning roles in ECM

Users do not need any specific role in order to log in to ECM. However, in 
order for users to see a particular Location, Cabinet, Drawer, or Folder in the 
user interface, they must have the :Reader role as a minimum requirement. As 
a result, domain users with no global roles might not be able to view anything 
in the content unless they were granted the appropriate privileges.

You should grant the ChemStation users the :Contributor role. This can be done 
at the global level for the entire ECM Account, or individually for specific 
folders (see “Roles and Folders in ECM” on page 75). The :Contributor role 
allows the ChemStation user to view and add content to ECM. The :Contributor 
role should be enhanced with the Content: Add Folder privilege. This allows 
ChemStation ECM users to add folders to the LCDF hierarchy.

Name Description

Roles starting with “:” Default ECM roles; can be restored by the Reset 
Roles function.

Privileges starting with "Content:" Privilege related to creating, modifying or 
deleting content in ECM.

Privileges starting with "System:" Privilege related to administrative tasks in ECM.

NOTE If the role does not include the Add Folder privilege, the users cannot add a new Remote 
Data Path (LCDF) in ChemStation.
74 ChemStation with ECM Concepts Guide



Administration Regarding 21 CFR Part 11 Compliance 4
Users/Groups/Roles Configuration
In addition to the configuration of ECM roles, you must also configure 
ChemStation roles and privileges for ChemStation users. The configuration of 
ChemStation roles and privileges is done in the OpenLAB Control Panel.

You find a complete list of all ECM and ChemStation privileges in the 
Appendix.

Roles and Folders in ECM

ECM allows you to assign specific roles to users or user groups. This can be 
done at the global level for the entire ECM Account, or individually for specific 
folders. For example, a specific user group may have the Contributor role for 
folder A, but at the same time have only the Reader role for folder B. The roles 
you assign in ECM are only related to content storage in ECM; all roles related 
to ChemStation and instrument settings are assigned in OpenLAB Control 
Panel.

To enable roles for folders:

1 In ECM, select the Administration page.

2 In the navigation pane, select the Account Administration node.

3 Double-click the Users/Groups/Roles item. 

The Account Administration dialog opens.

4 On the Roles tab, select the required role and click Edit.

5 Select the Available in folder access tab check box.

Preparations If you want to assign roles at the folder level, you must first enable this feature in ECM. The setting is 
valid for the complete ECM Account.
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Settings in OpenLAB Control Panel

Users in OpenLAB Control Panel

If you use an external authentication provider such as ECM, you cannot create 
new users, but must import users that exist in the authentication systems. A 
search function helps you find specific users in the authentication system. In 
the OpenLAB Control Panel, you can manage the roles for those external 
users, but not the actual user credentials such as user name and password. If 
you want to remove an external user, you unmap the user in the OpenLAB 
Control Panel. The user continues to exist in the external authentication 
system.

Groups

If you use an external authentication provider, you can either import the 
names of groups that exist in the external system or create new internal 
groups. There is no limit on the number of groups that can be mapped or 
created. In OpenLAB Control Panel, you assign the required users and roles to 
the groups. The assignment of users to a group is independent of the settings 
in the external system.

If you delete or unmap a group, the users who where members in this group 
remain unchanged.

Roles and Privileges in OpenLAB Control Panel

You can create a tree of different locations in the OpenLAB Control Panel, and 
add instruments to the relevant locations. With these locations you can 
organize your instruments for example by department, by room, or by table.

Roles are used to assign privileges to a user or a user group, either globally or 
for a specific instrument or location. The system contains a list of predefined 
roles which are installed as part of the system installation (for example, 
Instrument Administrator, ChemStation Lab Manager, or ChemStation Operator). Each 
role has certain privileges assigned.

For more information on changing the roles and privileges, refer to the 
OpenLAB Control Panel online help.
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Specific Privileges for Individual Locations or Instruments

By default, the roles of users or groups are globally set; that is, a user or group 
has the same role for all locations and for all instruments. The role settings are 
inherited from the root node Instruments. In order to assign a different role to a 
user or group for one specific location or instrument, you can deselect the 
Inherit access control from parent check box in the Edit Privileges dialog for the 
required node. Afterwards, you can assign a different role that will be valid 
only for the specific location or instrument.

For example, a user is a member of the group ChemStation Operator in all 
locations, but in one specific location he is a member of the group Instrument 
Administrator. 
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ChemStation Administration Tool

The ChemStation Administration Tool offers a number of functions related to 
the ChemStation configuration. As one of these functions is to break the 
session lock, access to the ChemStation Administration Tool is strictly limited:

• The ChemStation Administration Tool can only be opened directly on the 
ChemStation PC. In Distributed System installations, you must open the 
tool on the relevant AIC.

• The ChemStation Administration Tool can only be started by users who are 
a member of the local user group CSAdministrators (see “Enabling users to 
start the ChemStation Administration Tool” on page 79).

To start the ChemStation Administration Tool:

1 From the Start menu in the Task Bar, select Start > All Programs > Agilent 
ChemStation > ChemStation Administration Tool.

Figure 19 ChemStation Administration Tool
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Enabling users to start the ChemStation Administration Tool

During the Installation of OpenLAB CDS ChemStation Edition, the local user 
group CSAdministrators is automatically created. Only members of this group 
are allowed to run the ChemStation Administration Tool. The user who 
installs ChemStation, is automatically added to the CSAdministrators group. 
Additionally, the Windows group Administrators and the user who installs 
ChemStation are granted Full Control privileges on the Administration Tool 
program executable (Agilent.ChemStation.ECM.ECMAdmin.exe) itself, thus 
they are able to run the tool.

To add a Windows user to the CSAdministrators group:

1 From the Start menu in the Task Bar, select Start > Settings > Control Panel > 
Administrative Tools > Computer Management.

The Computer Management window opens.

Figure 20 Computer Management window
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2 Right-click the group CSAdministrator and select Add to Group... from the 
context menu.

The Properties dialog shows the users who are currently member of the 
group.

3 Use the Add button to add the required users.

After confirming with OK, the Properties dialog also contains the newly 
added users.
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Session Lock Settings

Figure 21 ChemStation Administration Tool

In the ChemStation Administration Tool, you can set the following options for 
creating and breaking session locks:

• Break session lock: If you select this check box, a locked ChemStation can be 
accessed by any user just by clicking Cancel in the Login dialog. If a 
ChemStation is currently locked and the authentication provider is 
unavailable, selecting this check box is the only way to regain access to the 
current ChemStation session.

•  Time based session lock locks private: If ChemStation has been locked by a 
session time out, only the current user or a user with the required 
privileges can unlock this session.

• Toolbar lock button locks private: If ChemStation has been locked using the 
Lock button on the ChemStation toolbar, only the current user or a user 
with the required privileges can unlock this session.

NOTE Be aware that, as a consequence, the user who regained access to ChemStation now has 
unlimited access to all ChemStation functions.
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Data Handling and Audit Trail Configuration 

The ChemStation Administration Tool offers to conveniently configure all 
ChemStation instances on a client at the same time with the same settings. By 
default, the option Use instance specific settings is selected, so that the settings 
are not overwritten.

To change the settings for all ChemStation instances

1 Select the option Use these settings for all instances on this computer.

2 Select the required check boxes. The settings are the same as in the 
Preferences dialog (see “ECM Preferences” on page 23).

3 Click OK.

Configuration Profiles

By providing specific configuration profiles, you activate specific functions 
and behaviors in ChemStation. The following profiles are relevant if you use 
OpenLAB Shared Services:

• Olss

ChemStation communicates with OpenLAB Shared Services; it sends status 
information to the Shared Services, and uses the settings defined in 
OpenLAB Shared Services (for example, user authentication, roles and 
privileges, configuration settings, audit trail settings). Use this profile for 
ChemStation instances that are connected to OpenLAB Shared Services, 
but have no connection to ECM.

• OlssEcm

In addition to communication with OpenLAB Shared Services, 
ChemStation allows data storage in ECM (upload and download of data 
files). Use this profile for ChemStation instances that are connected to both 
OpenLAB Shared Services and ECM.

You can also use the OlssEcm profile in emergency scenarios, when the 
authentication provider in OpenLAB Shared Services is set to None. In this 
case, ChemStation cannot upload data to ECM, but it still sends the data 
files to the queue. Therefore, when the authentication provider in OpenLAB 
Shared Services is set back to ECM, the upload can be resumed.
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Electronic Signature

Electronic signatures provide a means to sign documents as equally binding as 
a handwritten signature. In addition, electronic signatures are reproducible, 
because they are recorded in a secure, time stamped audit trail. Manipulation 
is prevented by enabling only users with specific privileges to sign 
electronically.

An electronic signature contains the user name (full name), date, and time 
when the signature was applied, the location where the signing occurred, and 
a user-configurable definition associated with the signature. The signature is 
always related to the complete result set, not to a single file inside the SSIZIP 
file.

CFR 21 Part 11 requires that companies, especially ones that employ any type 
of approval process, use electronic signatures. With the help of the Agilent 
OpenLAB Business Process Manager (BPM) module, you can create highly 
automated review or approval processes including e-mail notification.

Preparation

Privileges

An ECM user needs to have the privilege Content: File Signatures in order to be 
able to sign electronically. This privilege is, for example, assigned to the ECM 
default role: :Approver.

Reasons for the signature

With each signature the ECM users must either select a given reason or, if they 
are allowed to, provide their own reason. 

To configure the reasons for signatures:

1 In ECM, select the Administration page.

2 In the navigation pane, select the Account Administration node.
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3 Double-click the Electronic Signature item. 

The Account Administration dialog opens.

4 To provide a new reason, enter the required text into the Reasons field and 

click .

5 To delete an existing reason, select the reason in the Default reasons list and 

click .

6 If you want to allow users to provide their own reason with a signature, 
select the User can specify reason check box. 

7 If necessary, adjust the timeout settings:

• The Signature screen timeout defines, how long an e-signature dialog will 
stay open if no signature is submitted. The default setting is 5 minutes.

• The Consecutive signature timeout is relevant if an ECM user carries out 
several successive e-signatures. If the next e-signature takes place within 
the given timeout interval, the location and the reason provided in the first 
e-signature will be pre-filled in the next dialog. The default setting for the 
consecutive signature timeout is 5 minutes.

Using electronic signatures

To apply an electronic signature

1 Right-click the required SSIZIP file and select Electronically Sign > Electronic 
Signature from the context menu.

The Electronic Signature dialog opens.

2 Enter your ECM user credentials (username, password, and domain).

NOTE If you clear this check box, the users can only select one of the given default reasons.

NOTE The other command in the context menu, Electronically Sign > Acrobat Plug-In 
Signature, works only for PDF documents and only if you purchased the according plugin. It 
enables you to add signatures directly inside PDF documents.
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3 Enter your current location. With this information, the location from where 
you provide the signature is reproducible.

4 Select a reason for the signature from the Default reason drop-down list.

- Or -

Select the User specified check box and enter a different reason into the text 
field. Note that this option is only available if the ECM Account is 
configured accordingly.

5 Click Sign.

The file is now signed electronically. The e-signature is shown in the file 
properties in the eSig tab. The e-signature is also included in the ECM Audit 
Trail.

To view electronic signatures

The user preferences in ECM can be configured in such a way that the number 
of e-signatures applied to a file is shown by default in the ECM content display, 
together with the file name and status.

The electronic signature itself is shown in the file properties in the eSig tab, 
and it is also part of the ECM Audit Trail.

To adjust the user preferences: 

1 In ECM, select the Administration page.

2 In the navigation pane, select the Account Administration node.

3 Double-click the User Preferences item. 

4 Click Modify... to modify the column settings.

5 Select # of signatures and click  to add this property to the selected 
columns.

6 Click OK.

The number of e-signatures is then shown on every content page in ECM.
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This chapter provides an overview of the available ECM Attribute Extraction 
Services (AES) for ChemStation data. The AES extract metadata information 
from the ChemStation data files. These metadata make the ChemStation data 
searchable. For detailed information, refer to the ECM documentation.
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Attribute Extraction Services for ChemStation Data

ECM Attribute Extraction Services (AES) provides the following AES for the 
extraction of metadata from ChemStation data files:

• The ChemStation XML filter extracts peak, compound and result data from 
the result.xml file generated by the XML export routine in ChemStation 
revision A.10.02 and later.

• The ChemStation filter extracts basic sample and run data from the header 
of the channel files (*.ch), *.uv and *.txt files generated by all ChemStation 
revisions.

AES need to be installed by an ECM Administrator on the ECM Server; in 
addition, the filters need to be enabled for the system. The keys of an AES that 
are to be applied to a ChemStation file need to be selected for the respective 
LCDF structure. These are ECM administration tasks, and are described in the 
Enterprise Content Manager Administrator’s Guide and the ECM online help.

The metadata can be queried using various search types in ECM. The ECM 
Search functionality is also available within ChemStation. When opening a file 
from ECM, the ECM Open dialog allows you to search for files of interest using 
the ‘magnifying glass’ icon, see Figure 22 on page 89.

Using the Quick Search, you can search through various alphanumeric fields 
by entering a search key, such as an operator name. On the upcoming search 
page, you select the Advanced tab where, depending on the enabled filter 
packages, various keys are enabled, see Figure 23 on page 89.
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Figure 22 Search options

Figure 23 Filters available in search options
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In the Search dialog, you can specify the available keys, and it is possible to 
define a search expression by combining two or more of the available keys 
using boolean operators. For detailed information regarding the use of the 
various search algorithms, refer to the online help of your ECM system or the 
Enterprise Content Manager Administrator’s Guide, as well as the AES-related 
manuals.
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ACAML Filter

ChemStation stores all data in the ACAML format (ACAML = Agilent Common 
Analytical Markup Language), which results in .acaml files. There is one 
.acaml file for each sequence or single run. The .acaml files are always created 
when acquiring or reprocessing data.

When the data is uploaded to ECM, the .acaml file is part of the SSIZIP file. 
The ACAML filter extracts information from these files.

Please note that the ACAML filter is only available as of ECM 3.3.2 SP1.
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ChemStation XML Attribute Extraction Service

The AES for ChemStation XML extracts key information from the following 
categories of the result.xml generated by ChemStation per data file. Note that 
ChemStation must be configured to generate the result.xml file, see the 
ChemStation XML Connectivity Guide. 

• Acquisition (for example, instrument name, method information)

• Chromatogram (for example, derivative order, detector name)

• Custom

• Module

• Peaks (for example, peak name, amount, retention time, compound name)

• Sample (for example, calibration method, LIMS ID)

• Signal/noise
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Attribute Extraction Services for ChemStation Data 5
ChemStation Filter
ChemStation Filter

The AES for ChemStation extracts attributes from *.ch, *.uv, and *.txt files 
created by the 16-Bit ChemStation (Rev A.x.x) or 32-Bit ChemStation (Rev 
B.x.x or later). It extracts key information from the header of ChemStation 
*.ch and *.uv data files (for example, sample name, method file, instrument 
model). From the report.txt file, it extracts key information (for example, 
sample name, acquisition method, analysis method). In addition, the service 
extracts information on support files from the category Content.

An ECM Scheduler Add-in for Agilent ChemStation enables the ECM 
Scheduler to automatically upload data generated by ChemStation to ECM.
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ChemStation Filter
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6 Troubleshooting
Error messages at OpenLAB Control Panel Startup
Error messages at OpenLAB Control Panel Startup

Connection to Shared Services failed

When the ECM server or the Shared Services server is not available, the user 
cannot start the OpenLAB Control Panel. As ChemStation is launched from 
within the OpenLAB Control Panel, working with ChemStation is not possible.

Probable cause Suggested actions

1 The ECM server or the Shared Services 
server is not available.

• Reconnect: Try again to start the OpenLAB 
Control Panel.

• Ping: Ping the Shared Services server.

• Switch to Failover mode: If the connection 
to the Shared Services server cannot be 
re-established in a short period of time, 
switch to Failover mode. For more 
information, refer to the application note 
Emergency Procedures for OpenLAB CDS 
ChemStation Edition.
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Troubleshooting 6
Alerts and Error Messages at ChemStation Startup
Alerts and Error Messages at ChemStation Startup

Your Transfer Settings/Remote Data Path seems to be set to default

At every startup, Agilent ChemStation checks whether all necessary 
information is provided for transferring data to ECM. This message is shown if 
the Remote Data Path is not set or is incomplete.

Probable cause Suggested actions

1 The Remote Data Path is not set or is 
incomplete.

Make sure that the information on ECM Server, 
ECM Account, and a complete LCDF path is 
provided in the Transfer Settings (ECM > 
Preferences > Transfer Settings).
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6 Troubleshooting
ECM Server is not available after login
ECM Server is not available after login

If the ECM Server connection is interrupted after login to the OpenLAB 
Control Panel, the user has been authenticated by the ECM system. In this 
case, ChemStation knows the current logged-in user.

When the ECM Server becomes unavailable, ChemStation automatically tries 
to reestablish the user login.

The ECM Load and Save functions are accessible, but an alert informs the user 
about the interrupted connection to the ECM.

While acquiring data, the automatic transfer of data to ECM cannot be 
completed. The user is notified by an error message. and must manually 
upload the data as soon as the connection is reestablished (ECM > Manage 
Queue).

As soon as the ECM Server is available again, all ECM tasks are available 
without restarting the application. A new login is not required.

For further troubleshooting, please contact your ECM administrator.
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Troubleshooting 6
Error Messages in the Spooler Queue Manager
Error Messages in the Spooler Queue Manager

Current connection to '<account1>', expected connection to 
'<account2>'

Currently no connection, expected connection to '<server>'

The queue already contains items

Invalid license ID or license has expired.

Probable cause Suggested actions

1 Account setting in Preferences differs from 
current connection.

Correct the Transfer Settings.

Probable cause Suggested actions

1 ECM Server in Preferences differs from 
current connection.

Correct the Transfer Settings in the Preferences, 
e.g. use Get Server to get the current ECM 
server, and add the server and the correct ECM 
account to the Transfer Settings.

Probable cause Suggested actions

1 There are items in the queue that have been 
queued before the current item.

Process queue in the correct order. If necessary, 
export items that can't be resolved.

Probable cause Suggested actions

1 Server license timeout. Log out and log in again.
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Error Messages in the Spooler Queue Manager
You do not have permission to create a new Drawer/Folder.

You do not have permission to add files. 

Unable to upload (filename). This file is currently checked out to 
another user and may not be updated. (error -1).

Invalid path specified

Probable cause Suggested actions

1 You do not have appropriate privileges to 
create the Drawer or Folder.

Ask an administrator to give you the 
corresponding privileges or to create the needed 
directories.

Probable cause Suggested actions

1 You do not have appropriate privileges to 
save files to the specified location in ECM.

Ask an administrator to give you the 
corresponding privileges.

Probable cause Suggested actions

1 Another user has checked out the file. The other user has to check in the file before 
you can upload the file.

Probable cause Suggested actions

1 Occurs for a Commit action (that is, the item 
in the queue is not the first version of the 
data to be uploaded). The previous version 
cannot be found in ECM. It has been moved 
to another LCDF or deleted from the queue 
before upload.

Export the item to local disk and upload it 
manually to the desired location in ECM.
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Troubleshooting 6
Error Messages in the Spooler Queue Manager
Invalid URI: The format of the URI could not be determined

Probable cause Suggested actions

1 The ECM server has been entered in the 
preferences by name only, not as URI (http:\
\servername\).

Correct the server in the preferences, e.g. by 
using Get Server.
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6 Troubleshooting
Error Messages in the Spooler Queue Manager
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7 Appendix
ECM Privileges related to ChemStation
ECM Privileges related to ChemStation

The privileges described in the following table must be assigned to at least one 
of your roles in order to become active.

Table 3 List of ECM related privileges

Privilege View Edit Delete Add Run Description

Content: File X X • Minimum privilege for ChemStation 
to access ECM

• Privileges to view ECM Properties in 
ChemStation

Content: File Filtering X • Minimum privilege for ChemStation 
to access ECM

• Privilege to add files manually to an 
ECM folder

Content: File Revisions X • Privilege to view revisions in 
ChemStation

Content: File Type [XLS] X X • Privilege to add and check in files 
with an .xls extension

Content: Folder X X X • Minimum privilege for ChemStation 
to access ECM

• Privilege to view ECM Properties in 
ChemStation

Content: Folder Access 
Properties

X • Privilege to view and change any 
folder property tab

Content: Rekey File X • Privilege to rekey files in ECM e.g. 
with XML Filters

System: Advanced Search X • Privilege to use the Advanced 
Search in ChemStation 

System: Audit Trail X • Privilege to view ECM Properties in 
ChemStation
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ECM Privileges related to ChemStation
System: Filtering 
Configuration

X • Privilege to view or change the 
filtering configuration

• Privilege to use attribute extraction 
services and to manage 
user-defined attributes

System: indexing 
Configuration

X • Minimum privilege for ChemStation 
to access ECM

• Privilege to view ECM Properties in 
ChemStation

System: Quick Search X • Privilege to use Quick Search in 
ChemStation 

System: Super Object X • Privilege is mandatory for OLIR

System: Project X • Privilege to view projects in OLIR

System: Project Access X • Privilege to access projects in OLIR

Table 3 List of ECM related privileges

Privilege View Edit Delete Add Run Description
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ChemStation Privileges in OpenLAB Control Panel
ChemStation Privileges in OpenLAB Control Panel

Project Privileges

Table 4 Project Management

Name Description

View project or project group User can see a project and project details but 
cannot edit. 
Note:This privilege is required for all users, even 
if ChemStation does not support projects yet.

Manage project or project groups User can create or edit project properties and 
can move the project but cannot access settings 
(EZChrom only; Projects are not supported in 
ChemStation).

Manage project or project group access User can view and edit the project access 
settings (EZChrom only; Projects are not 
supported in ChemStation). 

Table 5 E-Signature

Name Description

E-Signature Sign Data Files User can sign data files (EZChrom only; 
E-signature functionality is not supported in 
ChemStation).

E-Signature Revoke User can revoke signatures (EZChrom only; 
E-signature functionality is not supported in 
ChemStation).

Table 6 ChemStation: Control

Privilege Description

Run Acquisition Start acquisition (single sample or sequence) 
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ChemStation Privileges in OpenLAB Control Panel
Table 7 ChemStation: Data

Privilege Description

Delete Data User can delete data files in ChemStation 
Explorer

Manual Integration User can perform manual integration 

Save Data to ECM Interactive saving of data to ECM

Table 8 ChemStation: Instrument

Privilege Description

Modify instrument configuration User can modify the instrument configuration 
parameters

Table 9 ChemStation: Logbook

Privilege Description

Clear Logbook Clear the current logbook 

Save Logbook Save the current logbook

Table 10 ChemStation: Method

Privilege Description

Edit calibration table Create and modify the calibration table; change 
calibration settings

Delete method Delete a method in ChemStation Explorer

Edit integration events Modify integration events and perform Auto 
Integration

Edit ion labels Edit options for ion labels (LC/MS only)

Edit system suitability Edit noise ranges and performance limits

Enable audit trail Enable the audit trail for a specific method

Modify instrument method Modify instrument method parameters
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ChemStation Privileges in OpenLAB Control Panel
Modify method properties Modify Run Time Checklist and Method 
Information

Perform method recalibration Perform interactive recalibration

Save method changes Save method changes (includes Update 
Sequence/Master Method in Data Analysis 
view)

Table 11 ChemStation: Report

Privilege Description

Preview/print report User can preview/print a report 

Modify report User can modify report calculation/print style 
and can edit Instrument Curves dialog 

Table 12 ChemStation: Security

Privilege Description

Break session lock Unlock a ChemStation session locked by other 
users

Command line Turn on / off the command line

Manage transfer queue Access to the Transfer Queue and the Spooler 
Queue Manager 

Modify ECM transfer preferences Enable / disable the automatic upload to ECM

Table 13 ChemStation: Sequence

Name Description

Delete sequence User can delete sequences in ChemStation 
Explorer 

Edit sequence summary User can modify sequence summary report and 
extended statistics settings

Table 10 ChemStation: Method

Privilege Description
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ChemStation Privileges in OpenLAB Control Panel
Reprocess User can reprocess a sequence 

Save sequence User can save sequences to ECM

Table 14 ChemStation: View Access

Privilege Description

Access Companion view User has access to Companion view (GC 
ChemStation only)

Access Data Analysis view User has access to Data Analysis view

Access Diagnostic view User has access to Diagnostic view

Access Method & Run Control view User has access to Method and Run Control 
view

Access retention time lock User has access to the Retention Time Lock 
menu (GC only)

Access retention time search User has access to Retention Time Search menu 
(GC only) 

Access Review view User has access to Review view

Access Tune view User has access to Tune view (LC-MSD 
ChemStation only)

Access Verification (OQ/PV) view User has access to Verification (OQ/PV) view

Access Report Layout view User has access to Report Layout View, ability to 
create/edit/save report templates

Enable Batch view Enables all operations in Batch view

Enable full menu Enables the ChemStation full menu

Table 13 ChemStation: Sequence

Name Description
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Instrument Privileges

Administrative Privileges

Table 15 Instrument Management

Name Description

View instrument or location User can view and access a location in the tree, 
but not edit access security, can view 
properties.

Manage Instrument or location User can create and move locations and edit 
properties (name, description etc).

Manage instrument or location access User can view and edit the location access 
settings .

Run instrument User can start an instrument session.

Service instrument User lock or unlock an instrument.

Table 16 System Administration

Name Description

Manage printers Can add/remove printers and print server 

Edit activity log properties 

Archive system activity log Can archive (archive/delete) the system activity 
log and define archive automation settings 

Purge activity logbook Can purge a logbook after it has been archived 

Create administrative reports Can create any of the system admin reports 

Manage system components Can install/remove components (applications) 

Backup and restore Can create a system (DB) backup and restore 
the backup 
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ChemStation Privileges in OpenLAB Control Panel
Manage Security Can change security settings.
Can edit (add, change etc) users, groups and 
roles.
Note: A user with this privilege can grant 
himself access to all settings in OpenLAB 
Shared Services. Be careful who you grant the 
Manage Security privilege.

Manage instrument controllers Can edit AIC configuration, manage the AICs in 
configuration UI

Unlock any locked UI Can login into any locked portal or instrument 
session (will be a re-login), even if privately 
locked. 

Table 16 System Administration

Name Description
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